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Introduction to LMS

s

e LMS Stands for Learning Management system.
e LMS is Cloud solution for Learning/Training module Of Sap HCM.

* LMS is a stand alone system and has its own direct link from success

factors login.
* Quick basic key terms in LMS : Item, Curriculum, Scheduled Offerings,
Registrations, Domains, Users etc.
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Topics to be Covered

* Introduction to Success Factors

* Introduction to LMS

* System Overview — Basic Navigations
e LMS Administrator

* LMS End User and Manager.

e LMS Configurations

* Reports in LMS
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1?rning Management System — Process

|dentify Learning needs of Organization

Capture Learning needs of organization in to System
Assign the Learning Needs to prospective employees
Capture tuition fees and costs associated with trainings.
Register for trainings and get approval from management.
Conduct trainings Internal and external to organization
Asses trainees by exams.

Record attendance for employees and provide the course completion
certificates.

Receive feedback on Trainings , Instructors , materials etc.
Conduct recurring trainings round the year.
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Pre- Requisites

Provisioning
Bizx Instance

SFTP Credentials

Super Admin - LMS for client ( Separate for Test , Development, and
Production ) , Raise the request via Partner Edge

iContent Server Credentials - 25 gb
Support Portal



Roles

* End User

* Manager

* Administrator ( Types of Admins )
* Instructor
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Steps sequence - Project

Provisioning -> Click on Company Name -> Company Settings

Enable Learning
Create Super Admin
Login in to Bizx Instance

Make Yourself as Super admin : Home -> Click on Admin Centre -> Click
on Manage role based permission -> Add the username s

Integrate SF Bizx and SF LMS



Login in to Bizx using the Super admin created in Provisioning
Click on admin center

Set User Permissions - > Manage role based permission access.
Adding the user



| e

Set User Permissions -> Manage Roles

Create Roles

Add permissions to role
Create Groups

Assign Users to Groups
Assign Groups to Roles.



Login Screen

Enter the URL into your browser

and hit your Enter key or click Go.

The SuccessFactors log in screen
displays (Figure 2).

Enter your username and
password and click Log in.

The SuccessFactors Home pabe
displays (Figure 3).
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Figure 3. SuccessFactors Home Page




Login Screen...Cont

successfactors”
A DAY LOTOY

3 Click your name (in this case,

Admin User (admin)) and select e TT———

Admin from the drop-down menu. i e — et
The Administration Tools page : g e pew el | T
displays (Figure 4). L | = - s
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Figure 4. Administration Tools

Click Learning and select
4 Learning Administration.
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” Login Screen...Cont

SuccessFactors Learning
Administration opens in a new
browser window (Figure 5).
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Figure 5. SuccessFactors Learning Administration




LMS - Standalone System Sign On

Enter the URL into your browser -
1 and hit your Enter key or click Go. ggkgsczexgus‘rfo?%Egrg
The LMS login screen displays. Adweinistration
Admin 1D:
Password:

Login

Forgot your password?

Figure 6. SuccessFactors Learning Login Screen

Enter your Admin ID and E—— .
2 password. r;lgn-‘“—'—';'-r_gw137

The LMS Welcome screen S e M) | s
displays (Figure 7). St ¥ | oo W e 1 i 5y oy
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Figure 7. LMS Welcome Screen




Learning Needs Management Model

Step

A o WO D

Action

Identify learning needs (outside SuccessFactors Learning).

Add items in SuccessFactors Learning.

Add curricula in SuccessFactors Learning.

Assign learning needs to users.

Record learning events.

1

Identify Associate Needs
-What needs o be in Histor™
- Online?

MNeed Software? ED
Azzocize - Instructor Led?

Meed g Room ¢
MNeed matsrials?
- Fre-requisites?
- Maming Conventions™

y Add ltem
- Instructor Led?
=] - Onling?
- In a Catalog™

ltern Diefinition - Frarequisitas?
- Substitutes?
- Subject Area?
- Required? Cpdonal?

0

3

Y Add Curricula

e e, - Add lrems

| - | - hake Required?
- Sub-Curncula?

Job Curriculum

- Build Motifications
Add attachments

" If rescheduled:
change segmants
change notifications
re-send notifications
Taols Menu

On-Going Process

- Departmearts | Groups?
One Time Setup

Add a scheduled offering Asgign Learning Neads Record Learning Event
(for Instructor Led) - A5sgn Curricula s kems
- Determine Dates § Times

G (Segments) - Enroll

LT -Raoms Adminer i
Logistics
2 - Resources A LEAMIAG Learner iseff enroll) Ak g aming

Reporting

- Fostars

- Completion
- Learning History
- Action Lists

Ceartificates

Reporting :Analysls
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LMS Administrator

e ) N
* User Management' User Scheduling & Resource
® Learning Management. Assignments Enroliment Management
. %/
* Online Content Management r ~
Y Resource Management. Competency SUCCESSF.aCtorS Access to Online
Management Learning Content
* Security Management. \ ,
Report M t i ) ) i
* Repor danagemen :
P 5 Cosi Tieckig & Training Record Online Testing &
Revenue . .
* Commerce Management. Management Keeping Evaluation

| G 2, Y, Y,




Success Factors LMS
ing Management Workflow



ep 1 — Enable Learning Integration
Provisioning

¢ Enable SuccessFactors Leaming infegration
auccessFactors Leaming Integration UR htps://partner)335. scdemo successactors com

auccessFactors Leaming Integration API URI https://partner0335.scoemo. successfactors com

" Enable grantng SuccessFactors Leaming ol to pemnission qroups — raquires Role-based Pemission This il disable Adminstate Domains] and ‘Enable



Step 2 — Integrate SF Bizx AND SF LMS
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ltem

An item is an assignable unit that can be tracked in the SuccessFactors
Learning system. It may be a learning or non-learning activity.

* [tem Types

* [tem Classification

 Attributes of an Item

* Domain Of an Item can Never be Public
* ltem SCREEN — Core, Related and Actions



ltem Key

First, an item key needs to be established. The item key is the unigue identifier
in the database and is made up of three parts:

» Item type (reference): This is a globally defined reference that helps
categorize items. When you create a new item, you must choose from the
defined list. Subsequently, each “type” has an associated “completion
status.” This is an admin-defined reference used when recording a learning
event.

» Item ID: This is a unique identifier for each item within the SuccessFactors
Learning database. It is recommended that a standard ID nhaming
convention be applied to items and all records in the system. Item IDs can
also be auto-generated by the system if the configuration is enabled.

» Revision date/time stamp: The system will default to the current date/time
and version 1. The admin can manually override the data in these fields as
needed.

Some examples of item keys include:

» COURSE Safety-100 07/01/2004 10:15 AM EST
» OJT Mechanic-210 07/03/2004 12:22 PM CST
» EXAM OSHA-230 07/15/2004 1:35 PM PST



Pricing
Trainer
Equipment

/ Facility and Location

Item =
(e.g. Training, :
E-Learning. Event)

[ I I - -
(] ] — - -
[ I I ) - -

Curriculum Scheduled Offering
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More Info ltem

* ltems represent all the different types of training measures.

* Depending on the item type related data have to be added with the item
(e.g. Instructors, Equipment, Facilities and Locations to Courses; Online

Contents to Web Based Trainings)
* ltem Title, Description, [tem Goals and Audience have to be maintained
in the system languages.
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More Info ltem

* [tem records can be related with other objects in TrainM (e.g. Catalogs,
Scheduled Offerings and Curricula).

e Users get access to items only by the related catalogs



—
More Info Item

* ltem records belong to one Domain, Domains represent a training
provider. Domain of an Item should never be Public.

* Depending of your user profile in LMS you can either edit or display
items. The user of this example (Admin TrainM (10005016)) got writing
access authority for domain DE_CORP_BTC-DE. For items in domain
CORP_BTC this user got read-only access.
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Iltem Types

e Scheduled Only (items of this type can be Classroom courses)
* Online Only (items of this type can be Web-based tutorials)
e Scheduled and Online (items of this type can be Blended Learnings)

e Other (not used at BOSCH TrainM)
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ltem Classification

* Course

* WBT

* Webinar
* DOC

* DOC- A



~Attributes of an ltem

* [tem Title

* |[tem Description

e Approval Process

* Assignment Type

* Minimum and Maximum Registration
* [tem Revision date , Number , Time.

* Delivery Methods

* |tem Source

* RB Know How



Creating a NEW Training ltem

3
H Lab 1. Adding a New ltem

Step

1
2

Navigate to Learning > Items.

Click Add New.

Action

o O »~r O

Click to select the item type, Scheduled Only. The plus sign changes o a

checkmark.

Click OK.

Select an item type from the drop-down menu.

Enter an item ID.
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/ Creating a NEW Training ltem

Login as Admin
Click on Learning
Click on Entity Item
Click on Add New




Parts of an Item — Item View in LMS

s

4 Ssarch Reauks

|« Cost Sharing
Description:

Ths courss will focus on cost shanng problems and their solutions. For various reasons, € 9., for
Tventory valuation for inandal accounling purpeses, for measurng proftability, pricing dedsions,

Classification: Instructor-Lad

Approval Process:
Assign. Type:  REQ (Required)
admin@plateau int

Creat Hours: 16.00

COURSE FA3M1 (Revi-1.. [T @ &

“Domain: Finance and Accourting (FA)
‘Approval Required: Mo

Related More @ Segments &) LR
EE oo Duration Delay Start  Location Type Actions  Delete

Online Content ] Selact Al

Competencies B Day1 =

Catalogs [ Cost Shenng-Dmy 1 1 [e00 1( | | classreom (CLat | v | Equipment  []

Subject Areas Cogpy To All

Proraquisites =) Day 2 F:

Scheduled Offerings | | CostShanng-Ony 2 | [som 10 | [classrcom (CLAs | v | Equipment [

Substitutes CopyTaAs
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~How do | maintain Additional Settings of a
new created Item

Additional Information Maintenance

How do | maintain Additional Settings ofa new created ltem (Step 2 - View All)?

IinToductdon:

Creating nevw iterms in TrainM is done in several steps:
P step 1:add new itermn (maintaining core data on the Sunmmary tab)
P step 2: maintain Additdonal Settings via View All

r step 3: maintain all the language related data / information (dtle, description, iterm goals,
audience)

P step 4: maintain Related data (C atalog, Subject Areas, etc.)

with this learning session the additonal data will be added to complete the core data on the
Summary tab (step 2).

1 kem Overview Screen

O wWith step 1 you learned howto create a new item. After clicking the Save & BExdt
button the new item was saved and you returned to the item ovenview screen. The
automaticall y generated Item-ID is displayed on this screen. The next step is to
Mmaintain additional settings of the created item.
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— How do | maintain Additional Settings of a
new created Item ...cont

)
6 Lab 2. Adding Information to an Iltem’s Core Area

Step Action

Using the item created in Lab 1, click the Assign. Type field and select
1 Required (REQ) from the drop-down menu.

Click Save.
Click View All & .

In the Summary section:

Click the Source field and select Internal (INT) from the menu.
Click the Enable User Requests field and select Yes (if not already
selected by default).

~ W DN
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~ How do | maintain Additional Settings of a
new created Item ...cont

® Min Registration

® Max Registration

® Auto Fill Registration

® Enable Users to waitlist

® Self Registration

® Supervisors Registration

® Users Can Record Learning events

® Supervisors can record learning events
® Enable User Requests

® |nitial Number, Period , Type (Due date calculation)
® Retraining Period , Number, Type
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~ How do | maintain Additional Settings of a
new created Item ...cont

® Contact Email

® Target Audience

® |[tem Goals

® Comments

® Delivery Method

® [tem Source

® Approver

® Approved By

® Approved Date

® Enable User ratings
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Core AREA

Core Area

The core area contains the basic information of the item record, including the
item title, item key, description, and classification. To edit any field in this area,
click in a displayed field and enter text or select a reference value (depending on

the field type). You can also view and enter additional information by clicking

View Al @ |ocated at the bottom left of the core area. Once expanded, the

screen displays the following sections where updates can be made:

» Title

» Description

» Summary

» Extended Summary
» Design

» Process Control



e
S

~How do | maintain Language related Data of
an ltem

* Item Title and Item Description

* How
 Why
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Related and More Area ... CONT

Scheduled Offerings

View future scheduled offerings of the item.

* Pricing.
° Notifications Available under More
; >
. RequeStS' Evaluations
e Evaluations.
Instructors

* Chargeback.

Notifications

* Instructors.

Objectives
Requests

Profit centers

Associate User Satisfaction, Mastery of Content, and
Application of Learning evaluations.

Associate and view the instructors authorized to teach the
item.

View/modify the Learning Expiration notification settings and
view/modify the registraion email templates.

Associate objectives associated to the item.
View/add user requests for the item.

View the purchasing options and the account codes that act
as the default profit center if a user's account is charged for
the training.




After Creating Training ltem

Create Schedule Offering ?? -> How ? What all are associated with SO ?

Make the Training AVIALABLE to end user to start receiving registration
requests.
Catalog to Assignment profileis 1 : 1 at least.

Trainin Assignm
5 Catalogs ent
Items
Profiles
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Catalogs

 What is Catalog Used for ?

Catalog is used for making items available in different way for different end
users.

® How to associate catalog to training items

® How to add new catalogs
® Pricing on catalogs



% Catalog...Cont

i Lab 5. Adding an Item to a Catalog

Using the item created in Lab 1, select the Catalogs tab in the Related
area.

WD

Click the Add New Catalogs icon.

Enter the keyword, KSO, and click Search.

Click the Add checkbox next to the KSO-GEN catalog.




Catalog...Cont

" Note: The Add Schedules checkbox should be checked if you also want to

add all existing scheduled offerings to this catalog.

Click Add.

S

Verify that all selected catalogs are displayed.

6
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Catalog...Cont ... Pricing

® Pricing AT Item level

® Pricing at Item level — catalog Level

® Pricing at scheduling offering level

® Pricing at scheduled offering — Catalog Level
® Charge back
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Catalog...Cont

Create Catalog:

Login as Admin

Click on Learning

Click on Catalog

Add New

Provide CATALOG ID AND Description
Create New
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Create Assighment Profile

Step 1: Login as Admin

Step 2: Click o Users

Step 3: Click on Assignment Profiles

Step 4: Click on Add New

Step 5: Provide id and Description

Step 6: Click on create

Step 7: Click on Manage rule

Step 8: Select Domain and SET RULES using employee user attributes
Step 9: Save and Preview users

Step 10: Propagate and recheck for users in preview under actions area of
Assignment profile.
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Approval Process and Approval Roles

Standard Role ( E, EM , EMM, EH, I)
Hard Core User
Relational Role ( Control Entity : Organizations / Domains ) .

Approval Process - > Approval Steps -> Approval Roles



SF LMS Admin Training - Test Training [tem
Internal Training Approval Process — Test Approval process
Approval Roles
Supervisor Level 1
Budget Approver
Finance Head
Test Data
Org Unit : IT
Test User : ABNDELK Test User’s Supervisor:
Test Catalog: Accounts pAyable , Test AP:Accounts Payable
Test Finance Head : TODADAIR
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Segments ON Item Level

 Add and Manage Segments
* How to add equipments and Location on segment level.
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Segments ... Cont

Working with Segments

The Segments tab of the item contains the default segments added when the
item was created. A segment is a block of time within a scheduled offering
(scheduled session of an item). The defaults are used to build out the actual
training schedule when the item is scheduled in the LMS. At the item level, you
can indicate the day, duration, delay start (of a segment), location type, and
equipment needed for each segment. Once a scheduled offering of the item is
created, a specific start date, start time, instructor, training location, and specific
equipment can be indicated for each segment.

If new default segments need to be added to an existing item, click the Add

New Segments icon () to add the new segments. Existing segments can
also be modified if needed.



Segments ... Cont

A
bj Lab 3. Working with Item Default Segments

Step Action

Select the Segments tab in the Related area.

1

In the Segments section:

Enter a description for each existing segment.
2 Change the duration of segment 2 to 4 hours.

Click Save.

Click —t to add a new segment and enter the following:

3 Day: 3
Description: Final Review
Duration: 4 (hours)

Click Save.




% Segments ... Cont



Subject Areas

Adding Subject Areas to an Iltem

Users have the ability to browse catalog/s by subject area. An item can be
associated with one or more subject areas. If an item has a subject area and is
available to a user through the catalog, the subject areas display on the Browse
Catalog page. The subject area titles may exist in multiple languages; users will
see the language of their locale.

¥

Related More &) Subject Areas | & L

Segments Title Subject Area D Remove

Online Content 1 a _| selectil

Competencies Accounting and Finance ACTFIM |

Catalogs Eudge! and Accouniing BUDGET ]
Compliance COMPL H|

Prerequisites
Substitutes
Scheduled Ufferings

Curricula

Tasks

Figure 5. Related Area of Item Record: Subject Areas
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Subject Areas

* Within Subject Areas there exist 3 categories: Competency field, Training
provider and Functional Areas.

* If possible add always values of all the 3 categories to the item, so that
users can find items by this search key.



Subject Areas...CONT

)
H Lab 6. Adding Subject Areas to an ltem

Step Action

Using the item created in Lab 1, select the Subject Areas tab in the
1 Related area.

Click the Add New Subject Areas icon.

Enter the keyword information. For this lab, enter Information
3 Technology.




Assignment VS Registration

Types OF Assignment :
® Self Assignment
® Supervisor Assignment
® Admin Assignment ( Manual Assignment)
® Automatic Assignment
Assignment Profiles
Job Code Based Assignment
Registration :
® Self Registration
® Supervisor Registration
® Admin Registration/ Slots ( Advanced Booking)



Instructor

* How to add instructors
* Who is primary Instructor.
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Scheduled Offering

* What is a Scheduled Offering?
* How to create a SO for an Item.
e Attributes of a SO

* Registrations on a SO

* [tem Requests
e Related More Area of a SO
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Prerequisites , Substitutes

* Prerequisites

How do | specify Prerequisites for attending a Course?

Introduction:

O nthe Prerequisites &b, you can identfy one or more prerequisite items that users should
complete before thay can selfregister for a scheduled offering of this itam.

1 hHem Record - SuccessFactors Administration

n C lick the Click to expand the Related region {

L]

L+

If users do notcomplets each Prerequisite, then they can still requesta scheduled 1

offering of this item but cannot self-register for the item in any of their available
catalogs. If users attemptone or more Prerequis ite items butdo not pass (or if users

pass an item thatgrants a substitute for one or more Prerequis ite items), then the
system warns (but does not prevent) you from registering the user for a scheduled

offering of this tem.

e Substitutes

How do | specify a substitute for an Item?

Introduction:

On the Substitutes tab, you can identify one or more Substitute items that users can complete
to receive credit for this item.

Item Record - SuccessFactors Administration

@ Cnocx syvem

#  Learning Administration - Acmin TrIEM (10006016)

ES |
-+ Curricula can be identified as Prerequisite as well! L=l 1 sl & [i] o
llome  Users  Lzarning  Comtent  Commerce  System Admin Referemces  Reporis
G s v Searrh | Crier Fepwords or Commend Gop -
Learning Administration = Admin TrainM (100050°5) -
. [HR-BE-BP01] Being HR Eusinass Partnar-B RALIRSF 757 (Rev1 - 2202014 Actions

- -
. z
q - “Description: ESl @
Wome  Users  Learmna | Conwt  Commerce  Systm Admin References  Rigoris = . -

— = e Cover Py ancive)

earchs | Evier Kt i o (sor) & R e Sockmark

COURSE 2562 (Rav 1 - 2WMa2014. Actions Classihcation: IrsiuctorLec *Domain: Cemeny Uomorate BIU JE(JE

[HR-EE-BP01] Being HR Business Partner-8
g

*Desenption:

Aswroval Process:

Related Vaore & Scheduled Offerings

: Comtont

Hrerquisites

Location

Domaln: Garnan - Carsarste - BTC-DE (CE
“Max Registration: 12
Souree:  Corporato Standard (CORFORATE

Aoproval Reauired: No

Status.

No Records

) buton.

==

Send athisben

ovies

EBC-]

Selatn

“Min Registration: 1 “Max Registration: 12

Lengtn (nrsj; 1e0 Souree; Coporais Standerd (COMOR:
Approval Procass: Approval Required: ko
View N )
Related Mare & Scheduled Offerings

Schwduled Olerings G Lacation status

Cataloge
Subject Areas
Segmants
Oulime Content Mo Records
Currieula

I'rerequisites

ll Click the Click to expand the Related region ( = } button.



Adding an Instructor

Adding an Instructor

How do | add any authoari==d rnstbuuctor o anm ltermnm@

Imntroducton:

O the itaertis R aelated More —— = Insthuctors tale canmn e asuathorized / oreffered imnstu ctors linke d
wwitdh the iterm.

L —- The orirmary Duarpose of authori=zimg am imnstuctor to teach am iterm is to rmake it easier
for other adrministators to selaect amn imnsouctor for the Primanrw Insbhuctaor Qbo=< of o
scheduled offering record Leaming=_Scheduled Offerings =SS aegrmenrits talo ) .

1 am adrmrminisoator imserts or selects amn insouctor wWho is mot authorized t© teach dthe
Itermim tdhe Primasy Instbthuctor Dox then tdhe systerm vwarms (oot does Nmicot preverit) the
adrrinistoator frorm saelectdng am iNnstuceor wWhio s Nmot authori=zed O teach the iterm. Y oa
carn Suathorize am imsou ctor BB teach amn iterm im bvwo places: om the itermrecord
(Learming FtertsAnstuouctors tals) or the imnstau ctor record

{(Learming =nstou ctors =Outhori=zed to Taeach talks).

- e Recosd - SuccessFoctors Saodenimisbiation - MMuozilla Firelos =10 =<
- Learning Administrariom - Acmin Trommh (100050100~
= g
— a» -
Sy e Flbrrt T Reports
[(Ser ) b
[HR-BE-BP01] Being HR Business PartnerB coumse v 1 - ZOMaamEo1 Action= 1w A
“Deccoripr . e nrrion
Teaining = PSR — merm e
=P AR Pt
™
Covar Page (nact_..
Clmssification: |nstructorl e “Domain: . Sorporate - BTC OE (o=
Fert Mot
i FTmgem et 10 R MR g mtemti—as 12
= - Coey
Langth (hrs): 1550 Bonira:  torporote Sharderd (CHONERORATE oo
Ao An —
Related [E=s)s Scheduled Gfferings : =
- Date Time Location. status
Caralcgs i
Subjact Arans st amize e 0900 Eure el emn

Fogons e
Caline Content
Curricula

EN click the Related More (uere) buvperink.



Notifications



Iltem Request

* How to check Item Requests as a Admin

* How to raise a request for a Item from user, manager and Admin
perspective.

Introcducton

Identifying how manrny employceaes has requested a Scochaduled O fferilg meaeds a4 shoeps:

S earching for thea neaeded 1=

C heck the minimurm nuenmber of registratdons in the 1=

) $34 124, 144

C heck the numMmiber of employee's requesis .

C heck the numMmber of stll bookable seats arnd the delivery date of available S chaeduled
O fherirmngs.

T he follo vwing session shows you the procedure to identalhy thae number of employees requesb=d
a Schaduld e O ffering -

n Searching for thhe neaeded Hoermn

T he docurmentaton arnd the systerrm simulaton at hanmd provide only the ap proach to identfy the
NnumMmiber of employseses req uesthaed for a Scheduled O fliering is associabaed with thiroug h anmn

exxarmple. For the practical realization in the productve systerm you havwve o use the according
data , values or factors ..
= 1To=rvrs will

be mainained on the Learming vievw of Trainivi . C hamnge © twe Leasrming
wie w o search for and open the neaeded 1=
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Registration

* Available Registration Statuses.
* Pending, Enrolled, Withdrawn, Waitlisted.
* How to do Registration for a Training ltem.
* How to withdraw from a Registration.
 Admin registration.
* Notification Emails.



Admin Registration

* How do | enroll Users to a Scheduled Offering who did not request the

Course?

Howw do 1 ernroll Users o a Scheaedualed Offering vwho did mot regueest the Colwmsae?

It o cdy scti om:

Usually users self-erwmoll to scheduled offerimgs. O Ny im exceptional cases the T raimning
AdmMmiinistrator /7 C ourse Administrator errolls users to a scheduled offerimg dlusers withhout a
recuest omn thhe course).

T his actionmn is only domne by Traimimng Administrators /7 C ourse Administorators if the deadlimne of
errollMm et does mot allow users to self-errtoll to scheduled offerimg.

If Traimimng Administrators /7 C ourse Administrators ernroll users (without reqque st omn the course))
yvou have to keep im mimnd, that the aApproval Process will be excluded.
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Adding Slots

* How do | add Slots for NN Users of an Organisation ID?

Howww o 1| adddd Slobts for Hjaed Users of amn Orcganisation I

Iyt ochsctioers:

Slols are seats im the scheduled offerimng that you camn resernve for amn organization . If you select a
Slok I, thhermn the sy sterm autormatical ly registers users (who belonmng to that organi=zation ) imto sy

arvailable slots that the ocrgani=zation reserved .
Slots camn oy bhe used by users of who belong to exacthy the indicated Organization 1> of the

slot.

A Schecduleccd OfFfering Recorcl - SuccessPFachbors Administe-aton —
Relatec] - Regist—atdon

T he docurmermntaton anmnd the sy sterm sirmulaton at hanmd provide only the approach to idemtify

catalogs and iterns associated withh through am exarrmple. For the practical reali=zatiomn im the
productive sy sterm »oul hawe to use the according data ., walues or factors.
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Resource Management

* Physical Resources.

* Location.

* Equipment.

* How to configure

* How to add them at SO level.
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System Administration — Custom Columns

* Define Custom Columns

e System Admin - > Custom Columns -> Users

e System Admin -> Custom Columns -> Scheduled Offerings.
e System Admin -> Custom Columns -> User

e System Admin -> Custom Columns -> Instructor

e System Admin -> Custom Columns -> Organization



‘Course Completion Status
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Record Learning Financial

e Users — > Tools -> Record Learning Financial.

e Select SO
e Enter Profit and Cost Centre
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Security Management

* Roles

* Work flows Groups

* Work Flow ID — ( Function + Entity )

* Function ( Create ) and Entity ( Item ).
* Domains

e Domain Restrictions.
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Roles

* TrainM Administrator

* Course Administrator

* Product Manager

* HRBP Role

e Super Administrator

e Support Administrator
* Resource Administrator
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Domains

Level o

Level 1-1

) Level 2 -
Level 2 Level o - Level 2 - evz 2
1 5 3




APAC

Domain




* orkflows
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Domain Restrictions

Finance Admin-




'Admin Role Assignment



_
Domain and Catalogs

 Difference between Domaons and Catalogs
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Online Content Management -

® Deployment of Icontent server

How to upload content in to | content server

How to do you associate online content to Training ltem
Launch the Training

® Third Party Integration

® \/LS — Virtual Learning Services ( Business Skype , Cisco Webex ,
Macromedia flash)

® OCN — Open Content Network service provide ( 5- 6 vendors ) Udacity,
Courseware , etc



\/

lcontent Server - Credentials

iContent Credentials:
Link: https://sftpio.successfactors.com
User NAme : client

Password; **********
Port : 22 ( 95 % ) OR 25
URL : Varies from DC to DC



Upload Online Content



Content Settings

* SYSTEM Admin -> Configuration - > System Configuration
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Tasks — SF LMS

Tasks — Neither online nor classroom
Learning -> Tasks ( Create list of Tasks)
Create item with classification others
Add tasks

Maintain Task checklist settings

Users can add observers

Record learning or failure by observer



% Reporting
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Cost Formula, Cost
Summary, Cost
calculation, Cost
currency , Currency
parameter.

training

\ /

Additional
Cost

Realized

Offering Level

Pricing : Tution fees for the

Scheduled Catalog Level

Inventor
Account Codes
, Charge Back

Cancell
ation
Policies



Course Obijectives

Upon completion of this course, you will be able to:

-

-

Set base and additional costs for resources
Track delivery costs for a scheduled offering
Close a scheduled offering and capture realized costs

Describe how profit and cost centers work in SuccessFactors

Learning
Establish pricing for an item in multiple currencies

Use the Catalog Price Change Assistant to modify pricing of an

item
Create and apply a cancellation policy to an item

Control chargebacks to internal accounts, including

distributions across multiple accounts
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Success Factors Commerce

* SF Commerce is all about cost incurred to launch a training and pricing
charged as tuition against per registration.

¢+ Costs: This section details the process of tracking the
administrative costs of delivering training. Additionally, costs
can be defined to track user costs of attending training (such

as travel and meal expenses).



P

+

Pricing: This section details the process of tracking the amount
a user is charged to take training, including assigning prices to

items and scheduled offerings, and setting a chargeback method.

Managing Transactions: This section details the process of
managing transactions, including setting a cancellation policy,
calculating realized costs for a scheduled offering, editing
completed orders (transactions), and posting transactions for

export to a financial system.
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Key Terms in SF Commerce

e Resource Cost : Amount charged against use of resources for each scheduled
offering ( Resources: Instructors, Locations, Equipment's)

e Account Code: A code use to record chargeback information of financial
transactions and they are associated with users, Org Units, Items, SO.

* Price : Tuition Fees per employee per registration.

e Cost center : Account Code which is charged or from which the amount is
debited. Debit Account code.

e Profit center : Account code which is credited.
e Cost Name: Specific Costs with reference to Item or SO or Resource.
Eg : Lodging Cost, Boarding etc.



P
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Resource Costs

Upon completion of this lesson, you will be able to:

+

Describe base costs and additional costs
Describe how cost names work with resource costs
Apply costs to resources

Describe how currency settings work with resources and

scheduled offerings

|dentify the characteristics of the scheduled offering Cost

Calculation and Cost Summary tabs



P —
Types of Resource Costs

Costs can be established for resources and those costs carry into a
scheduled offering when a resource is used during a segment of the
offering. There are two types of costs that can be set for a resource,
base cost, and additional costs. Once a scheduled offering is
complete, an admin is able to enter the realized cost and close the
scheduled offering, committing the financial transactions to the

database.
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Base Costs for Resources

Resources such as instructors, equipment, and locations can be
assighed a base cost. The base cost is applied to scheduled

offerings every time the resource is assigned to a segment. The
administrator can set the base cost at the resource level to be a
“fixed” cost or allow it to be overridden when applied to a
scheduled offering. Administrators set an amount, currency, and

unit of measure for the base cost (Figure 1).



Additional Costs

* Additional Costs refer to the other specific cost incurred on each
resources in particular.

Eg : Travel cost, Lodging , Meal Expenses for a Instructor

* Prior to use of Additional cost we first create the entity called cost name
with correct resource type selected so that this cost name will be
available to the admins at resource level while adding additional cost.

e Additional costs can be overridden at SO level.
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dding Base Cost to Resources

Lab 1. Adding Base Costs to Resources

Add Base Cost to an Instructor

Step

1. Navigate to Learning > Instructors.

2. Enter criteria to search for an instructor and click Search.

3. Click the edit icon to access the instructor record in edit mode.

4. Select the Base Cost tab (located on the left).

5. Enter a value in the Amount textbox.

6. Select a currency from the drop-down menu.

7. Select a unit of measure from the drop-down menu.

8. Click Add.

9. Check the Allow override of default base cost at time of scheduling

checkbox.

10. Click Apply Changes.
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Add base cost to location

Add Base Cost to a Location

Step

1. Navigate to References > Physical Resources > Locations.

2. Enter criteria to search for a location and click Search.

3. Click the edit icon to access the location record in edit mode.

4, Select the Base Cost tab.



Add base cost to location....Cont
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tens to create Cost Name

@ Lab 2. Adding a Cost Name

Step

1. Navigate to References > Commerce > Cost Names.
2. Click Add New.

3. Enter a cost name in the Cost Name textbox.

4. Enter a description in the Description textbox.

5. Click to check the Instructor checkbox.

6. Click Add.

7. Click the X to close the window.

8. Repeat steps 2 - 4

9. Click to check the Location checkbox.

10. Click Add.
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e
Steps to Additional costs to Resources

@ Lab 3. Adding Additional Costs to Resources

Add Additional Cost to an Instructor

Step

1. Navigate to Learning > Instructors.

2. Enter search criteria to search for an instructor and click Search.

3. Click the edit icon to access the instructor record in edit mode.

4. Select the Additional Costs tab.

5. Search for and select the cost name created in Lab 2.

6. Enter a value in the Amount textbox.

7. Select a currency from the Currency drop-down menu.

8. Select a unit of measure from the Unit of Measure drop-down menu.

9. Click Add.
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Add Additional Cost to Location

=

—



e _
Add Additional Cost to Location...Cont

7. Select a currency from the Currency drop-down menu.
8.  Select a unit of measure from the Unit of Measure drop-down menu,

9. Click Add.

10.  Close the References window.



i
Important Note

* Now we can assigh the resources to SO at segment level.

* The Costs associated with resources directly will get reflected in the Cost
summary Tab of SO.

Note : THE COSTS ARE DISPLYED ONLY IF THE COST CURRENCY
PARAMETER OF COST CALCULATION TAB IS SAME AS CURRENCY
SELECTED WHILE ADDING THE COSTS TO RESOURCES. IF NOTO IS

DISPLAYED ON COST SUMMARY TAB.



View Resource Costs at SO Level
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View Resource Costs at SO Level...CONT

9. Select Add Location from the drop-down menu.
10. Check the Add checkbox next to the location you set costs for in Lab 1.
11.  Click Add.

12. If not selected, click the radio button to make the instructor and

location you selected the Primary resources for the segment.
13.  Click Save And Close.
14.  Click More from the Related area.
15. Select the Cost Summary tab.

16. Do the costs for the resources display?
If so, the lab is complete.

If not, continue with Step 17.
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View Resource Costs at SO Level...CONT

17. Select the Cost Calculation tab.

18.  Select a cost currency that matches the currency you used in your

resource setup.
19.  Click Apply Changes.

20.  Select the Cost Summary tab and view the resource costs.
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Account Codes

* Account Code is simply a ID used in Financial information systems for
financial transactions.

e Account codes are associated with users and Organizations.
* Types of Account Codes: Cost Center and Profit Center

* Cost Center : Charged from or Debited from Account Code
* Profit Center : Account code which is credited.



Jane Williams
Account Code: 009012

Steven Smith Williams
Account Code: 002134

Jane and Steven enroll into a scheduled offering of MS Word
(price $500) being sponsored by the IT Organization
(account code: 002134).

Cost Center Armount Profit Center Amount
009012 (S500) 002134 S500
002134 (S500) 002134 S500
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Adding Account Codes

@ Lab 5. Adding Account Codes

Step

1.

Navigate to Commerce > Account Codes.

Click Add New.

Enter an account code ID in the Account Code textbox.

Enter a description for the account in the Description textbox.
Select a domain.

Click Add.

Repeat steps 2-6 to create an additional account code.

/ |
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- Adding Account Codes to Organizational Units
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Adding Account Codes to User

@ Lab 7. Assigning Account Codes to a User

Step

1. Navigate to Users > Users.

2. Enter search criteria to search for a user record.
3. Click Search.

4. Click the user ID link to access a user record.

5. Click the More from the Related area.

6. Select the Account Code tab.

7. Enter an account code created in Lab 5.

8. Check the User Can Use Org Accounts: checkbox.

9. Click Apply Changes.
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Closing and Cancellation of SO

e Realized Costs

* At time of closing or cancelling the scheduled offering there might be
some resources costs which would have actually not incurred entire
amount so changes are still possible which is done at realization stage.

* Once resource costs are realized the SO is closed and there is no way
back for modifications in LMS for that SO.



Closing a Scheduled Offering

@ Lab 8. Closing a Scheduled Offering with Realized Costs

Step

1. Add a new scheduled offering with a start date/time in the past.

.......

Note: The system displays a warning message that your date is in the past.

2. Select the Segments tab from the Related area.

3. Double click the segment in which to assign an instructor and assign the

instructor and location you set costs for in Lab 1.
4, Click Save and Close.
5. Click More from the Related area.

6. Select the Cost Summary tab.

/ |
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“Closing a Scheduled Offering ... Cont
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15.

16.

17.

18.

19.

Closing a Scheduled Offering ... Cont

12.

Click the expand icon (&) next to the specific resource to view/edit the

cost details for that resource.
Update the cost for the resource.

Click Apply Changes.

receive a warning message that you are overriding the defaults. If this message
displays, click Yes to proceed.

Select the X to close the window return to the scheduled offering record.
Click the Close the Scheduled Offering link from the Actions area.
Review the scheduled offering ID and closing date. Modify if necessary.
Click Next.

Click the expand icon to expand the Scheduled Offering Total.

/ |
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/Closing a Scheduled Offering ... Cont

20. Click the checkbox next to each resource for which a cost was realized

for the scheduled offering.

7 Note: To capture individual resources of a specific type, click the expand arrow next
to each specific type.

21. Click Update Total.

22.  Click Next.

23. Enter the cost center and click Add.
24. Click Next.

25. Enter a profit center and click Add.
26. Click Next.

27. Review the information, and click Finish.
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“Closing a Scheduled Offering ... Cont
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Cancellation of a Scheduled Offering

@ Lab 9. Cancelling a Scheduled Offering

Step

1. Add a new scheduled offering with the instructor created in Lab 1.
2. Click More from the Related area.

3. Select the Cost Summary tab.

4, Click the expand icon (@) next to Instructor.

5. Click the expand icon (@) next to the specific resource.

6. Change the additional cost amount to $500.

7. Click Apply Changes.

8. Click X to close the window.

9. Click Cancel the Scheduled Offering from the Actions area.
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Cancellation of a Scheduled Offering...Cont
8. Click X to close the window.
9. Click Cancel the Scheduled Offering from the Actions area.
10. Review the scheduled offering ID and cancellation date. Modify if

11. Click Next.
12. Click the expand icon to expand the Scheduled Offering Total.
13. Click the Expand All link.

14. Click the checkbox next to each resource to include in the realized costs

for the scheduled offering.
15. Click Update Total.
16. Click Next.

17. Enter the cost center and click Add.
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Cancellation of a Scheduled Offering...Cont

18.  Click Next.

19.  Enter a profit center and click Add.

20.  Review the percentage for distribution.
21.  Click Next.

22.  Click to check the appropriate checkboxes on the Post Cancellation

Action Settings screen.
23.  Click Next.
24.  Review the information on the Confirm screen.
25.  Click Finish.

26.  Click OK.
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LMS Commerce : Pricing

* Pricing is the tuition fees, applied at Item, curriculum, Organization level.
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Pricing at Item

@ Lab 10. Applying Pricing to an Iltem

Step
1. Add a new instructor-led item and it to one or more catalogs.
2. Click More from the Related area.

3. Select the Pricing tab.
4. Enter a default published price in the Price textbox.

5. Click to check the Scheduled Offering Can Override Item Prices

checkbox.
6. Click Apply Changes.

This starts the Master Inventory Price Change Assistant.

7. Click Yes on the Master Inventory Price Change Propagation screen.

Level

/ |
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Pricing at Item Level ...Cont

8. Click Next.
9. View the default price/currency.
10.  Check the Apply price change to catalogs: checkbox.

11.  If desired, enter a price in additional currencies and check the Add

checkbox next to each.
12.  Click Next.
13.  Select all displayed catalogs.
14.  Click Next.
15.  Select all displayed orders.

16. Click Next.



Pricing at Item Level ...Cont
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Change Catalog Prices

@ Lab 11. Changing the Default Published Price of an Item

Step

1. Access the item created in Lab 10.

2. Select the Catalogs tab from the Related area.

3. Click Change Catalog Prices.

4. Change the default price in the appropriate Price boxes and check the
Add checkbox next to each.

5. Click Next.

6. Select all orders.

7. Click Next.

8. Review the catalog price change summary details.

9. Click Finish.

IS Note: Existing scheduled offerings are not affected by the price change. To change the
price for a scheduled offering, go to the Pricing tab within the scheduled offering
record.

/ |
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Pricing at SO Level

* Pricing can also be done at SO Level.
 Catalog prices can also be changed at SO Level.
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Cancellation Policies

A cancellation policy can be applied to an item in the master
inventory. You can create as many policies as you need, but only
one policy can be applied to a single item. These policies contain
a set of rules that dictate how users should be charged (if at all)
when they withdraw from a scheduled offering. The combination
of delivery offset days and rule types each make up one rule

(Figure 17). These rules consist of:

+ Delivery offset days (days before or after the first day of the
scheduled offering)

+ Rule types

+ No charge

¢ Charge full price

+ Charge percentage

¢ Charge fixed amount



Cancellation Policies...Cont

There must be one active (future) scheduled offering in the

master inventory in order to apply a cancellation policy to an item.

Q

References

Calendars & Time 3

Cancellation Policies | Commerce b
Cost Mames Compensation ¥
Currencies Geography 3!
Order Status Learning 3
Pricing Rules Perfarmance b

*"‘I’m—__
Physical Resources  p |

System admin [

User Management  » ||

| —

Figure 17. Cancellation Policy Record



Add new Cancellation Policies

@ Lab 12. Creating a Cancellation Policy

Step

1. Navigate to References > Commerce > Cancellation Policies.
2. Click Add New.

3. Enter an ID for the cancellation policy.

4, Enter a description for the policy.

5. Click Add.

6. Select the Rules tab.

7. Enter -21 in the Delivery Offset (Days) textbox.

"V Note: A neegative (-) number should be used for days leading up to the scheduled
offering; a positive number (+) is for days after the scheduled offering.



Add new Cancellation Policies
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Applying a cancellation Policy

@ Lab 13. Applying a Cancellation Policy

Step

1. Create a scheduled offering for the item you created in Lab 10. Have the

start date be within a week of the current date and allow users to self-

register.
2. Navigate to Commerce > Master Inventory.

3. Search for the item that you scheduled in Step 1.

R
7 Note: Click Add/Remove Criteria to add the Items search criteria. Search for and
submit the item search criteria.

4, Click Search.

/ |
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Applying a cancellation Policy...Cont

5. Click the edit icon to access the record in edit mode.
6. Select the cancellation policy you added in Lab 12.

7. Click Apply Changes.

1ol g3y
¥ Note: There must be a future (active) scheduled offering of the item in order to
apply the cancellation policy.

8. As a user, register into the scheduled offering and then withdraw. The

system displays a message about the cancellation and refund.
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Pricing Rules

Pricing rules are simply a single percentage discount that can be
applied against an entire catalog. In order for this change to take
effect, the automatic process for catalog pricing must run. Each

catalog may have one pricing rule assigned to it.



Pricing Rules...Cont

Figure 18 depicts the pricing hierarchy process.

Master
Inventory

Items SKU Scheduled
Offerings

Figure 18. Pricing Hierarchy Process



Adding a New Pricing Rule

@ Lab 14. Adding a Pricing Rule

Step

1. Navigate to References > Commerce > Pricing Rules.

2. Click Add New.

3. Enter an ID for the pricing rule.
4, Enter a description of the pricing rule.
5. Enter a value for the discount (%).

6. Click Add.
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/Applying a Pricing Rule to a Catalog

@ Lab 15. Applying a Pricing Rule to a Catalog

Step
1. Navigate to Learning > Catalogs.
2. Enter criteria to search for a catalog.

3. Click Search.
4. Click the Catalog ID to access the catalog record.

5. Click the pricing rule field and select the rule added in Lab 14 from the

Pricing Rule drop-down menu.

6. Click Save.

7 Note: The pricing rule is applied to all items contained in the catalog that have a
price.






Evaluation Surveys



* [tem Evaluation
* Learning Evaluation — Pre and Post exams
* Follow up evaluation. ( Efficient Implementation of learning)
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Sample Screenshot — Item Evaluation Survey

Questionnaire Surveys Search | gl
= %2arch » Search Results = Edit Item Usage

Survey ID: Level 1 Survey

Mame: SuccessFacters Global University Feedback Suney

Edit tem for the Survey

Add an [tem to the Survey

Enter tem 1D or odd one ormors: from s

Summary Type Ie=rm T
Cuestions v :
ltem Usage , Update the ltem Usage for the Survey

Options — : ]u

Motifications

Sederr Al Decsdecr A
le=m Assigned  Completions  Percentage  Mean Score  Remove
COURSE ADMDADR (Rev 4 - 12/23/2004 02:38 FM 0 0 0.00 Hi& ]

Americal Hew Tork)

Ledort Al / Deccloct Al
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Configurations in a Questionnaire Survey

* Summary

* Questions

* Options

* [tem Usage
* Notifications
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Creating a New Survey

@ Lab 1. Create Draft Survey and Add Questions: Item Evaluation

Step

1. Navigate to Learning > Questionnaire Surveys.

2. Click Add New.

3. Enter a survey ID.
4. Enter a survey name.
5. Select an evaluation level (for this example, select Item Evaluation:

User Satisfaction).

6. Enter survey description.
7. Enter comments.
8. Select domain.

9. Check Active checkbox.



Creating a New Survey ... Cont
10.  Click Add.
11. Select the Questions tab.
12.  Enter survey instructions.
13.  Enter first page title.
14.  Enter first page instructions.
15.  Click Add Question icon ([a).
16.  Enter question stem.
17.  Select question type (rating scale).

18.  Select a rating scale.



-
Creating a New Survey ... Cont

19.  Repeat steps 15-18 to add additional questions.
20.  Click Add Page icon ([2).

21.  Enter second page title.

22.  Enter second page instructions.

23. Click Add Question icon (Iﬂ).

24.  Enter question stem.

25.  Select question type (rating scale).

26.  Select a rating scale.

27.  Repeat steps 23-26 to add additional questions.

28. Click Save Draft.
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Configuration Options

* Required for item completion can be checked if mandatory.
 Anonymous reply from users.
* Days to complete can be configured.

A comment section can be added after each question for additional
feedback per question.



/ onfiguration Options

Questionnoire Surveys

= S=arch = S3earch Results » Edit Options

search = Add Naw | g

Summary

Questicns

Survey ID: JSER_GAT

Hame: SuccessFactons Global University Feedback Survay

Item Usage

Edit the Survey Defaults

Options

Notifications

Anonymous Survoys:

Required For [tem Completion:

Days to Comploto:

Include Comments Field for each Cuestion:

@ Yes DiHo

@ Yes @ Mo

Apply Charpges
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Notifications

NOTIFICATIONS

There are two notification templates associated with the

questionnaire survey functionality:

+ Questionnaire Survey Assignment Notification Email Template

+ Questionnaire Survey Assignment Notification RollUp Email

Template

A user is sent a notification upon the assignment of a survey. (It is
recommended to embed a questionnaire survey direct link into
the notification template to generate an actual link within the
email.) An item evaluation survey is assigned to a user upon
completion of an item (a learning event is recorded) (Figure 6). A
follow-up survey is assigned to a user and/or the user’s supervisor
in a configurable number of days after item completion and is

triggered by an automatic process manager (APM).
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Notifications

@ Lab 2. Configure Options and Notifications for Draft Survey: Iltem
Evaluation

Step

1. Access survey record from the previous lab.

2. Select the Options tab.

3. Select Yes for anonymous surveys.
4, Check the Required for Iltem Completion checkbox.
5. Enter number of days to complete survey from assignment.

6. Select option to include comments field for each question.



10.

11.

12.

I e AN
Notifications...Cont
Click Apply Changes.

Select the Notifications tab.
If necessary, edit body of notification message.
Click Apply Changes.

If necessary, click Browse to add an attachment to notification.

Click Apply Changes.



Preview AND Publish

PREVIEW AND PUBLISH

Once a survey has been created, it is important to preview the
draft survey before publishing and making it available for use.
From the Questions tab, click the Preview button and select

Draft for an option to preview the draft version of the survey
(Figure 7).



Preview AND Publish
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" How to Add Items to Survey: Method 1

@ Lab 4. Associate Survey with Item: Item Evaluation

Step

1. Select the Item Usage tab.

2. Click the add one or more from list link.
3. Search for one or more items.

4. Select one or more items from results list.

5. Click Add.
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How to Add Items to Survey: Method 2

@ Lab 5. Associate Item with Survey: Item Evaluation

Step

1. Navigate to Learning > Items.

2. Search for an item.

3. Click the item key link to access the item in edit mode.

4, Click More from the Related area.
5. Select the Evaluations tab.

6. In the Item Evaluation: User Satisfaction section, click the search icon

() to search for and select a questionnaire survey.
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How to Add Items to Survey: Method 2...Cont
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Learning Evaluation —=Survey

@ Lab 6. Associate Pre- and Post-Exams: Learning Evaluation

Step

1. Navigate to Learning > Items.

2. Search for and access an item record in edit mode.

3. Click More from the Related area.

4, Select the Evaluations tab.

5. In the Learning Evaluation: Mastery of Content section, click the drop-
down menu for pre-exam and select the desired exam.

6. Click the drop-down menu for post-exam and select the desired exam.

7. Click Apply Changes.



e
Steps to create Exams using : QE

In general, the steps involved in creating exams in Question

Editor include:

1. Identify and create the objectives (optional, but needed for

question pooling on exams).
2. Create questions in QE related to the objectives.
3. Create a new exam.
4. Add questions to the exam.
5. Create a new item.
6. Add exam to the item.
7. Define online settings for the item.

8. Test the item and exam in the SuccessFactors Learning user

interface.
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PARTS OF A QUESTION

/tem - Course on Geograth
__________ ]

Exam Object 123

1 |- Question stem

—

I

| QZ China is on the continent: ]

| | § '}f_', — Correct answer
| ~

| I

® Asia
O Europe . 1| Oneormore
| o Africa I/ ~ distractors




Question Types in QE

True/False: Users select one of two distractors: True or False.

Multiple Choice/Single Answer (MCSA): Users select one of

multiple distractors as the correct answer to the question.

Multiple Choice/Multiple Answer (MCMA): Users select one or
more of multiple distractors. Users receive credit only when

all correct answers are selected.

External: Questions imported from another application outside

SuccessFactors Learning.



Question Screen Layout

+ Header: Displays the question name

+ Question setting menu: Lists each variant of the question

including the revision number, question type, and settings

+ Editing and formatting menu: Provides the tools to edit and

format the question
+ Question stem: Displays the question content

+ Correct answer(s): Select the radio button or checkboxes to

identify the correct answer(s) to the question

+ Additional Distractors: Display the incorrect answers

Header
Menu:
Question settings

Menu:
Editing and formatting

Question stem

Correct answer
(radio button is selected)

Distractors
(one or more Iincorrect
answers)

Question Name: TRN_Geog 01 [Unsaved)

FUTA

Luseet R

Multiple Choica ¥ [4] Randomize

W a0 X | [verdana [¥] [Smal  [¥] B A

China is on the continent: |
'® Asia
'O Antarctica

L O Africa

Palette: Question work space

Figure 2. Question Screen Layout
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/ Creating a Question In QE

* Log on Admin Interface of SF Learning
* Click on content -> Questions -> Add new



Creating a Question In QE...CONT

Add New Question K
4. Enter the question name and domain.

* Pequired items are indicated by an asterisk

L o , :
¥ Note: Avoid using spaces in the question name. If you do not know the The new question will be created with one variant:
domain, click the search icon to search for and select the domain.

“Wariant 1, Revision 1,

5. Select a question type from the Question Type drop-down * Question Name:
mend. * Domain:
6. Click Add. Q, lPuBLIC

Question Type:
7. Click the magnifying class to search for an objective. Multiple Chaice -

8. Enter search criteria in the Objective Search window.
Objective Information:

9. Click Search. Q, |

10.Select the desired objective. Objective Description:

Hittg A , _ ..
¥ Note: We will discuss more details for associating objectives to an exam m m

question later.

Figure 4. Add New Question Pop-Up Window



Creating a Question In QE...CONT
Add New Question Screen

You are taken to the Questions Add New screen (Figure 5).

Eearch  Add Hew  Hel

Objectire Name. SF-LAN-ADMIN-INTRO

o 1 Multiple Choice ¥ [ Randomize Paint Valua: 1.0 7] #uailable for Exams
W% G0 X | [via F[Tw [FB L U=s== |80 |0 3| @& 2| 5| By | Adons »
b Selected Question
g

Figure 5. Add New Questions Screen
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Creating a Question In QE...CONT
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Note

* An items’s classification may change when configuring to support
Learning evaluation model.

* For eg : If item of type Instructor led is configured with Learning
evaluation model it becomes blended but the same is not the case with
online , scheduled and online.



succassfactcprs" Learning Evaluation

BUSINESS EXECUTION SOFTWARE

Iterm: SuccessFactors Learning Training(COURSE,SFLEARMING 8162011 10:36 PM EDTRewv1)

Date Range: MNA - NSA

Total Learning Events: 1

Objective Mastery Analysis
@0 100

i

Score
coB88883¢8E88

Objective 1 Objective 2

Objectives

Figure 11. Sample Learning Evaluation Report
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Follow up evaluation Survey

* The follow up evaluation can be assigned to an item in a configurable
number of days form date of completion of item.

* The evaluation completion date is configurable days from the assigned
date.

* Participants can be employee only, employee and supervisor, supervisor
only.

* Comments fields can be added after each question.



‘Sample screenshot

Questionnaire Surveys Searcn | AddHew | @

« Search = Edit Options

Summary

Questions

Item Usage

Survey ID: FOLLOWURPOO

Mame: Folliow Up Learning Sursay

Edit the Survey Defaults

[ Options

Notifications

Post Evaluation : assign 120 Days fram It=m completion
alow [T Days to Complete

Participants : 0 Employes 0 Supervisor & Both
Include Comments Field for each Question: 7 yas @ o

Apply Chanpes
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Add New - Follow Up evaluation surveys

"

Lab 7.

Step

Configure Options for Draft Survey: Follow-up Evaluation

1.

Navigate to Learning > Questionnaire Survey.
Search for and select the follow-up survey just created in the activity.
Select the Options tab.

To configure the post evaluation settings, enter a number of days from
item completion to assign the follow-up survey, and a number of days to

complete the survey.

Select the follow-up survey participants (employee, supervisor, or both).

Select option to include comments field for each question.

Click Apply Changes.



_ -
Add New Follow Up evaluation surveys... Cont

8. Select the Notifications tab.

9. If necessary, edit body of notification message.

10.  Click Apply Changes.

11.  If necessary, click Browse to add an attachment to notification.
12.  Click Apply Changes.

13.  Select the Questions tab.

14.  Click Preview and then select Draft from drop-down menu.

15.  Click Close to close preview of survey.

16. Click Publish. The survev is now readv for use.



urvey Completion — END User

@ Lab 9. Launch and Complete Assighed Survey

Step

1. Log in to SuccessFactors Learning as a user.
2. Locate the survey on your To-Do List.

3. Click the survey title to launch.

4. Complete all questions/pages of the survey.

5. Click Submit.
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Competency Management

Competencies:
Project
Management

Competencies

Competencies

Competencies:
Project
Management

Job code

Competencies

Competencies
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Competency Management

Competency Assessment editor
Competency Assessment Recorder
Competency Gap Assistant



MS — Curricula Managem



Curricula

* Curricula may contain items, requirements and sub-Curricula. Depending
upon the Curricula settings, different entities within the Curriculum must
be complete for the Curriculum to be complete for a User.

* may also be published to catalogs which makes them available for User’s
to self-assign.

e Unlike self-assigned free-floating items, items within a self-assigned
Curriculum maintain the assignment type (required, optional, etc)
specified in the Curriculum record.

* Also, the use of retraining periods (see Period Based Assignments) and
calendar basis requires items to be contained in a Curriculum.



Characteristics of Curricula

General characteristics of curricula include:

*

ltems can be used in one or multiple curricula with different

date and requirement settings in each.

Modifications made to a curriculum have an immediate impact

on all users who have the curriculum currently assigned.

Curricula can be linked to a job position or assignment profile
and automatically assigned when a user is given that job

position or meets the profile attributes.

Curriculum can contain requirements (covered in the Learning

Extras section of this guide):

— # of Hours
— # of Hours from an Item Pool

—  # of Items from an Item Pool



—Curriculum Status

A status of Complete is issued to the Curriculum when any of the following occur:
*All effective, required items and requirements are complete and all sub-Curricula are complete.
*The effective date of all required items and requirements is in the future.

*Some of the required items and requirements are complete and the remaining required items and
requirements have an effective date in the future.

A status of —Incomplete is in effect when any of the following occur:

*A ?]ew Curriculum is assigned to Users and the effective date for any required items or requirements is
in the past.

*Any effective, required item or requirement has not been completed.
*A completed item or requirement has a retraining period and the required by date is in the past.
*The Curriculum is modified with a new or revised item and the effective date is in the past.



/ . .
Curriculum Creation

@ Lab 6. Add a New Curriculum

Step

1. Navigate to Learning > Curricula.

2. Click Add New.

Note: You can also enter Add Curriculum into the Search field below the button bar
and click Go.

3. Enter a curriculum ID.
4, Enter a title for the curriculum.

5. Enter a description of the curriculum, if desired.



/ . .
Curriculum Creation

6. Leave the creation date set to the default.

7. Select a domain.

8. Select a curriculum type from the drop-down menu.
9. Leave the Force Incomplete checkbox unchecked.

WS Note: When you select the Force Incomplete checkbox, the system calculates whether
the status should be complete or incomplete based on the user’s latest attempt at
completing the item. If the user’s latest attempt is incomplete, the system calculates
the expiration and required dates based on the date and time of the last unsuccessful
attempt.

10.  Click Add.



Table 3. Related Area Options and Descriptions: Curriculum Record

Assignment Profiles

Catalogs

Contents

Documents
Job Codes

View/modify the assignment profiles that push the
curriculum out to a target user population.

Associate catalogs to the curriculum that determines
which users have access to the curriculum (and items)
for self-assignment.

Associate items, requirements and subcurricula to the
curriculum.

Associate related documents to the curriculum.

View the job codes to which the curriculum is tied.
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~Three date settings associated with items when
used in Curricula:

* |nitial period, retraining period and effective date.

* initial and retraining period set at the item record level is inherited when the
item is added to a Curriculum and may be modified per Curriculum. This will
not change the default at the item level.

* Effective date is applied only to required items within the Curriculum, and
essentially determines when the item is required for Curriculum completion.
For example, in an existing Curriculum that is already assigned to Users and
potentially already complete by some, administrators may want to add a new
item to the Curriculum, but set the effective date to the future so Users have
time to complete this item and remain compliant until that date. After the
item becomes effective, it is required for Curriculum completion.
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~Period-Based Item Assignment (Initial
Assignment)

e Success Factors uses the Initial Period from the item record Design Data
tab to calculate the required by date (due date).

* When items reside in a Curriculum, they may have a Retraining Period
associated with them as well, which requires Users to complete the

training on a recurring cycle in order to maintain Curriculum completion
(compliance).

* There are two types of period basis settings to choose from: Event Basis
and Calendar Basis.



Event Basis Initial Period Examples:

Required Item .. Initial Period
Initial Number: 30 ‘Grace' Period |
Initial Period: Days 8 _
Event Basis
Item Assigred
2/15/07
User has the remainder of the current period type (1 Day) + the
number of periods (30 Days) in which to complete the item.
l |
| Jan | F_ff:: | M My I Jun | Jul | Aug | §&p I Oct | Mo | Dec
1/M1/2007 12/31/2007
Required By Date
aMTor

Required Item

Initial Number: 2 Item Assigned
Initial Period: Months S0 fo7
Event Basis User has the remainder of the current period type (1 Month) +
the number of periods (2 Months) in which to complete the item
|

| Jan | Fab I Mar | Apr m Jun | Jul o I Oct | Mo I Dhesc |

1/1/2007 12/31/2007

Raquired By Date
TI30007




~Event Basis

e Based upon the assignment date (or completion date for a retraining
period) the User has X number of periods in which to complete the item,
before it becomes overdue (item expiration email sent to User and
supervisor, alert on home page).

* The User always has the remainder of the current period type (e.g., 1
day, 1 week, 1 quarter, etc) + the number of periods defined.



e

Calendar Basis

* Case 1 : Static
e Case 2 : Curriculum Assigned Within Initial Threshold

e Case 3 : Curriculum Assigned Outside of Initial Threshold — No grace
period is available for user.

Eg: 2 month segment initial period, 30 days threshold — User has Grace
period



Calendar Basis Initial Period Example 1:
“Static” Required by Date

Based upon the basis date or 4/15/07 and

. ‘o INitial Period
Required item Grace' Period | the threshold of 335 days, if the curriculum
Initial Number: 1 \J - is assigned within the first 335 days of the
Initial Period: Year 2 . segment (4/15/07 to 3/14/08) the item is
Calendar Basis Initad Assignmeot Theshokd always due on 4/14/07. If the curriculum is
Basis Date: 4/15/07 assigned on or after 3/15/08 the item is due
Threshold: 335 days at the end of the next segment (4/14/09).
ltem Assigned Any Time
From 4/15/07 to 3/15/08
1 Year Segment from 4/15/07 1o 4/14/08
y/ 7 J L & /4
2008 2007
| Jan ab ar May Jun ul Aug Sep Nov
1172007 12/31/2007
Required By Date

4/14/08




Calendar Basis Initial Period Example 2:
Curriculum Assigned Within Initial Threshold (Threshold = Entire Period)

; ' m. - Initial Period
Grace' Period
Required Item \;’ Based upon the calendar segments starting
Initial Number: 30 on the item basis date of 1/1/07, User has
Initial Period: Days Initial Assignment Theshold the remainder of the current segment (13
Calendar Basis Days) in which to complete the item.
Basis Date: 1/1/07
Threshold: Entire Period If the item were assigned in the next period
(e.g. August) it would have been required at
"‘";,??70‘3"’“ the end of that period (because the
Threshold setting = ‘Entire Period’)

30 Day Segment
et

Jan Feb ar Apr Jun u
1/1/2007 | | 12/31/2007
Required by Date:

7/30/07




Calendar Basis Initial Period Example 3:
Curriculum Assigned Outside of Initial Threshold

Initial Period Based upon the calendar segments starting on the item
basis date of 1/1/07, User has the remainder of the current

'Grace' Period I
Required ltem \.‘ - segment (26 Days) + the next full segment (2 Months) in
‘ which to complete the item.
Initial Number: 2 lmh'mm

Initial Period: Months

Calendar Basis Because the item was assigned beyond the 30 day

threshold, the user is granted a ‘grace period’ of the

?::;::;2';;2:;5 ""‘; 3:3"“’ remainder of the current period and the item is due at the
| end of the next full period. If the item were assigned during
the first 30 days of the period (within the threshold) it
2 Mor*thfegmenl would have been due at the end of the current period.
" \

11112007 12/31/2007




Edit the Items for the Curriculum

= = Raguired if etther Initial Bazsis or Retraining Basis is calendar based.

Initial Assignments:

Initial Humber:
(1000,001)

Initial Basis:

Retraining Assignments:

Retraining Number:
(1000,001)
Retraining Basis:

= Basis Date: p—
W AARE P S l_._l
AR

LiiiE

Effective Date:
WA S My )

Assignment Type:

Initial Period:

) Calendar @ Event

| Retraining Period:
) Calendar 'S Event
JanA 2005
ALg 2520005
Reouired (REQ) - | &y

_ Dawys

Apply Changes

Entire

o
Threshold: =00

(=)

Diaws

Figure 10. Edit Items for Curriculum Window




@ Lab 7. Associating Items to Curriculum

Step

1.

Access the curriculum created in Lab 6.
Select the Contents tab in the Related area.

Click Edit.

Click the Add Content button ( Q- ).
Select Items from the drop-down menu.

Enter criteria in the keyword field to search for the items to include in

the curriculum.

Click Search.



10.

11.

Check the Add checkbox next to each item to add to the curriculum.
Click Add. The selected item(s) is added to the contents list.

Click the Edit link next to the last listed item:

a. Enter initial assignments (number and period).

b. Select an initial basis (event).

c. Do not enter retraining assignments.

d. Enter a basis date (if not defaulted) and an effective date (use the

current date).
e. Select an assignment type. Select Required (REQ).

Click Apply Changes.



12.  Click the Move Up (&) arrow and Move Down (&) arrow to sequence

the curriculum content. This sets the suggested order display for users.

13. Click the X to close the Edit window and return to the curriculum record.
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F LMS Content Objects
Workflow Group
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Online Content

WHAT IS ONLINE LEARNING?

Online learning refers to the electronic access of asynchronous
training, such as a slide show presentation, an audio or video
presentation, a web-based exam, or a document (e.g., a Standard

Operating Procedure manual).

SuccessFactors Learning enables users to launch online content
directly from their To-Do List and can automatically record

learning events for completed online items.



P

Content objects are the building blocks of an online item. A

content object is a pointer to a single, launchable file. For

It 1s important to note that the content object specifies the
content location and launch method of communication with
SuccessFactors Learning (e.g., AICC, SCORM, etc). It does not

store the actual content.



Table 1. Terminology Equivalents

Content Object Sharable Content Assignable Unit (AU)
Object (5CO)



SCORM is derived from AICC standards. One difference between
SCORM and AICC is the definition of content structure. AICC

requires four text documents:

¢+ course (.crs)

¢ structure (.cst)

+ description (.des)

+ assignable units (.au)

On the other hand, SCORM uses a single manifest XML file to

describe the content structure (imsmanifest.xml). This XML file

includes greater detail about the content than the AICC text files.
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Online Content Creation Process
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/

Online Content Creation Process ...Cont

4.

Add content objects/content packages in SuccessFactors

Learning.
Add an item in SuccessFactors Learning.

Assign the online content to the item during item creation or
under the Online Content tab from the Related area of the

item record in SuccessFactors Learning.

Test the online item from the SuccessFactors Learning user

application.

Assign the item to a catalog and/or to the user’s To-Do List

(Learning Plan).



Content Object Records



Field

Title

Domain

Build User
Build Company
Build Location
Build Date

Content
Object is
active

Content
Object is
online

Description

Developer
Tool

Mastery Score

Description

Indicates the name of the content object
and is used in searching.

Identifies admin ownership of the
record.

ldentifies the person who created the
content.

Identifies the company that created the
content.

ldentifies where the content was
created.

Indicates the final build date of the
content.

Indicates that the content object is
available/unavailable for item
assignment.

Indicates whether the content object is
available to users.

Describes the purpose/location of the
content object to users.

Indicates the software tool used to
develop the content.

This is the score required by the user to
COMPLETE the selected content object
(NOT the Item), and be awarded the
COMPLETED status for the corresponding
content object. If the Mastery score
indicated here is not achieved by the
user, the system marks the content
object as FINISHED.

Notes

Displays
to User



SLITI M3y

5
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Lsunch Method
Cihjectives
SICT Support

Cross Domain

Content Objects Search | Add Men | &

» m=arzh > Search Besutlts - Edd Suommary

Content Object ID: COMMOZ13

Edit the Content CObject

* = Peguired Figdds

Aoy crange:

* Tithe: ['W¥riting Effective Fusiness Documerns
*Domain: T, [HR
Build User: | Build Com pany:
Build Location: |
Build Date: [ |
(MM DA™ ™)
| Contert Skject is actve ¥ Content Doject iz online
Description: THiz cowes helps wou sccomplsh wetden

Doveloper Tool:
Mastery Score:

BUSINESS COMMUNICELIDN [h Sh SMeCiive manaer.
“wiou Wil Ieshn o construct clese, concise and
efM=ctve memos, busingess letters, reports, and

proposals.

| Sl oit

[ ooty changes | Reret | Gopy Cortont Obiect. | belete

Figure 1. Content > Content Object Record > Summary Tab



SF Learning Integration
onfigurations and Setup



SF Bizx Integration Integration with SF LMS

* Provisioning Settings
* Bizx Settings
* Super Admin settings
* SFTP Server



Provisioning Settings - Step 1

Enable Learning Integration — Inside Company settings

SuccessFactors Learning Integration URI = https://Variable-
stage.plateau.com

SuccessFactors Learning Integration API URI = https://Variable-
stage.plateau.com

https://client-stage.plateau.com/learning/admin/nativelogin.jsp



“Step 2 - d SP Asse

Service Provider Settings

Login in to Bizx : Create a user PLATEAU1

Roles: LMS Administrators, LMS End Users -> Provide Permissions for roles

Create Groups LMS Administrators — Add user PLATEAU1 TO Group LMS
Administrators, Assign the group to role LMS Administrators


https://performancemanager10.successfactors.com/provisioning_companies?pcoms_param_dest=pcoms_value_dest_comdetails&fbcomdet_p_com=thrivenieaT1&fbcomdet_p_action=fbcomdet_saml_sp_setting&_s.crb=GqdRnctbXm6pC4y0fMoDfax7NSE=
https://performancemanager10.successfactors.com/provisioning_companies?pcoms_param_dest=pcoms_value_dest_comdetails&fbcomdet_p_com=thrivenieaT1&fbcomdet_p_action=fbcomdet_saml_sp_setting&_s.crb=GqdRnctbXm6pC4y0fMoDfax7NSE=
https://client-stage.plateau.com/learning/saml/SSO
https://client-stage.plateau.com/learning/saml/SingleLogout

Step — 3 Settings in Stand Alone Link

Login in to stand alone link : Super admin id and password is provided
User name : PLATEAU, Pass word :PLATEAU

System admin -> Application Admin -> Admin Management
Create the Admin and End user: PLATEAU1

Add the Related User from Users search

If PLATEAU1 user is not there please create one ( User - Add New )


https://client-stage.plateau.com/learning/admin/nativelogin.jsp

—_—

ot

Step 4 — Super Admin

System administration - > Configuration - > System Configuration -> Bizx
1. successFactorsLearningEnabled=true
2. baseURL=https://performancemanagerio.successfactors.com
3. successFactorsCompanylD=Client
4. baseRESTAPIURL=https://performancemanagerio.successfactors.com

s.metadataProviders[IDPi].value=https://performancemanagerio.successfa
ctors.com/idp/samlmetadata?company=Client



Step 5

* System administration - > Configuration - > System Configuration ->
Connector

Sftp

Bizx System Text File of User data

Job 1: Export users from Import users from
Bizx to SFTP, SFTP to Ims, LMS
Provisioning Stand Alone
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Job 1;

Job Defenition : Job Name , Job Owner : PLATEAU, Job Type : Employee
export, character ENCODING: UTF 8

Server access:
URL: https://sttpio.successfactors.com
User : 7724688T
Pwd : kdTracsEEXAr
File path and File Name :
File path : /incoming
File Name : user data thrivenieaTi.txt
Job Occurrence and Notification
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Assign role all_ connector in system

Check Connector Properties, System administration -> Configuration ->
System configuration -> Connectors

Connector Properties and Field Mapping

System administration -> Connectors -> SF USER Connector -> Schedule

Job



/

Possible Errors

File Not Found - File Name

Prefix , connector.input.file.name.tenant.suffix.enable=true
Materialized View Error — Standard SF Error

Maintain Email id Correctly

Create Country


mailto:abc@xyz.com
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LMS and Bizx Configurations

* In the LMS, the necessary configuration settings are defined in the SF
Learning Admin user interface (Found under Learning Administration >
System Admin > Configuration > System Configuration > BizX).

* In BizX the respective settings have to be made on the customer
provisioning page (e.g.
).


https://qacand.successfactors.com/provisioning_login

e

= 1fegrating SF Learning with BizX — Configuration
Steps

On the LMS Side
eInstall Learning-only license and BizX Connectors license (on SF Learning)
*Provisioning access to the BizX instance

*BizX Core is used as the source system for basic user data in SF Learning (refer to the
BizX User Connector workbook for field mappings). Any updates made to common
fields directly on SF Learning will need to be manually updated in the BizX Core
application, i.e. user updates don’t flow from the LMS to BizX.

*BizX Core user IDs must match the SF Learning user IDs (and where applicable, the SF
Learning admin IDs) in order to utilize the SAML SSO solution.

*<SF_DOMAIN> and CompanyID have been obtained by BizX Prod Ops (e.g.
<SF_DOMAIN> = performancemanager.successfactors.com,
CompanylD=CustomerProd).

*<LMS_TENANT_DOMAIN> is known



e
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= 1fegrating SF Learning with BizX — Configuration

Steps

On the BizX Side

*Make sure a Company ID for the tenant has been created by BizX’s Product Operations
*Make sure the <LMS_TENANT_DOMAIN> is known

*Configure expected Learning activity statuses (“Planned” and “Completed”)

*If the standard security model is used, follow these steps:

Grant the “Learning Access Permission” under Admin > Manage Security for Learning User Access

Grant “Learning Admin Access” permission under Admin > Administrative Privileges > Manage
Security to display the Learning Admin Link

Grant “CDP Access” under Admin > Manage Security to allow users to access CDP
Grant “Jam Access”
Set the corresponding permissions in Admin > Manage Security > Default User Permissions



hese values are obtained through the provisioning request
SF_DOMAIN
SF_COMPANY_ID
LMS_TENANT_DOMAIN
LMS_TENANT_ID

LMS .properties files
baseURL

successFactorsCompanylD

performancemanager.successfactors.com
CustomerProd
Imsdomain.com

LMSTEST

https://performancemanager.successfactors.com

CustomerProd
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— Configuring theﬁnin:g Menu Using Role
Based Permissions

e To grant users with permissions to the “Learning Access” tab under
Administration Tools, navigate to:

 Manage Employees

* Set User Permissions

* Manage Permission Roles
e <select a role>

* Permission Settings

* User Permissions

* Learning

<select> the Learning Access Permission checkbox



* To grant admin users “Learning Admin Access” permissions under
Administration Tools, navigate to:

* Manage Employees > Set User Permissions > Manage Permission Roles >
<select a role> > Permission Settings > Administrator Permissions >
Manage Learning > <Select> the Learning Admin Access Permission
checkbox



—
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SL LMS USER
MANAGEMENTWORKFLOW
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User Management

e Users are represented by database records which contain not only
detailed demographic information but also about trainings which they
are actually assigned.

* Individual must have a User record in Success Factors Learning.
* User Connector.
* Assighnment Profiles.



w Sid Mormony

User Management

First Hamea: &id

smaormonyl (5| o

Picture:

“Domain:

Primary Superviscr:

Jobr Location:

Inclustry (IM )

Huoff, Marcus & [mhoff )

Last Name:
Job Code:

Organization:

*Rele:

Emp Type:

Mamany

Execuine (EXEC)

Industry (IND)
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EXF (Exempt EMplayes;

Related Maore &

Learning Plan

Learning History
Curricula
Competency Profiles
Competencies
External Requests

Azsignment Profiles

ons Wienw

Bookmark

Registration Assl..

Launch Proxy

View User's Tale..

B =mracs Altsrmat..
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Item Title Assigned By | Learning Information Remowve
L sedect an
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System AF
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Require.. | 1lq201 |
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Compl ...

Failure
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[Z7] a=zzign.
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User Management

* Navigation Step for User Management Configuration
* References > User Management > Corresponding Attribute.

* Click Add New
* Enter Corresponding attribute ID and description.



User Management

Shown below is how Employee Types are configured.

References > User Management > Employee Types
Click Add New

Enter Employee Type ID : SL1

Enter Description: Associate with employee subgroup SL1
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User Management

User Attributes
*User Status
*Gender

*Job Title

*Job Locations
*Gender

Job Title



Locate User Record

ﬁ Lab 1. Locate and View a User Record

A Hh W N =

Navigate to Users > Users.

Enter your search criteria in the appropriate textboxes.

Click Search.

Locate your user from the search resulis list.

Click a user ID to open the record.







Add a User Record...Cont

Step Action

Enter the number of years/months of prior service.
Enter the location of the user's resume.

Enter a hired date.

Select a related instructor, if applicable.

— T Sa

In the Address section:
7 a. Enter an e-mail address for the user.

Click Add.

8

Record the user ID.

9
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Assignment Profiles

* [tems -> Catalogs -> Assignment Profiles -> Users

* If users match the values defined in Assignment profile , they will have
the corresponding Training items in their learning plan.

* Assignment profile attributes are as follows: Domain, Location, Country,
Legal entity, Division.
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Add New User Information

* - Requred Fuds Add || Reset
— Security
= User 1D:
Active: o
* Dommain: O pypswc
* Role: (Sysbem Delayll User Roke) -
- Persomnal
Lost:
First:
pan:
Upload Picture File: [ Browse |
Fictures dnplay in 4:5 aspect rotio (180 x 175 pocois)
— Employrment
Jdobx Tithe:
Job Code: O
Job Location: -
Emp Type: -
Emp Status: -
Region: o
Prior Years of Service: . Years = MNonthis)
Hired: [79
(RARLDDNYYY )
Related Instructor: -
— Addross

Email Address:

Figure 68_ Adding a New User Record



